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Lampiran 1 

Rancangan Rangkaian Perangkat Keras 

 

 

Lampiran 2 

Proses Uji karakteristik Alat Ukur  
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Lampiran 3  

Proses Pengambilan Data Vibrasi Induced Draft Fan 
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Suhu pada biring motor induced draft fan 

 

Lampiran 4 

Program Arduino IDE 

#include <ESP8266WiFi.h> //library esp8266 

#include <WiFiUdp.h> //library protokol udp 

#include <Wire.h> //library untuk komunikasi serial sinkron 

dengan dua kabel yakni SDA (Serial Data) dan SCL (Serial 

Clock). 

#include <ADXL345.h> // library untuk sensor ADXL345 

 

#ifndef STASSID 

#define STASSID "Taufikk" 

#define STAPSK  "1234567890" 

#endif 

 

int remotePort = 2000;              // inisialisasi port 

client atau port NodeMCU Port 

unsigned int localPort = 8888;// inisialisasi port komputer 
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IPAddress remoteIp(192,168,147,85);//inisialisasi IP 

komputer 

 

char packetBuffer[UDP_TX_PACKET_MAX_SIZE + 1]; //jeda 

pengiriman data 

WiFiUDP Udp;//variabel udp merupakan turunan dari library 

wifi udp 

 

ADXL345 adxl; //variabel adxl merupakan turunan dari 

library adxl345 

 

void setup(){ 

  Serial.begin(9600);// kecepatan data per bit 

  WiFi.mode(WIFI_STA);// memulai pemanggilan wifi 

  WiFi.begin(STASSID, STAPSK);// memulai pemanggilan wifi 

  while (WiFi.status() != WL_CONNECTED) {// jika wifi tidak 

terhubung akab muncul pesan titik titik 

    Serial.print('.'); 

    delay(500);// delay 0,5 detik 

  } 

  Serial.print("Connected! IP address: ");// Jika wifi 

terhubung dengan hotspot  akan muncul 

  Serial.println(WiFi.localIP());// pesan pada serial 

monitor 

  Serial.printf("UDP server on port %d\n", localPort);// 

Connected! IP address: berisikan IP komputer dan 

  Udp.begin(localPort);// Protokol UDP dimulai 

   

  adxl.powerOn();// mengaktifkan sensor adxl345 

 

  //setting batasan aktif/ketidak aktifan (0-255) 

  adxl.setActivityThreshold(75); //setting batas aktif adxl  
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  adxl.setInactivityThreshold(75); // setting batas aktif 

ketidakaktifan  adxl 

  adxl.setTimeInactivity(10); // Setting waktu tidak aktif 

0,1 detik 

 

  //look of activity movement on this axes - 1 == on; 0 == 

off  

  adxl.setActivityX(1);// Melihat peregerakan aktif sumbu X 

Y Z, jika 1 =on dan 0 = 0ff   

  adxl.setActivityY(1); 

  adxl.setActivityZ(1); 

  

  //look of inactivity movement on this axes - 1 == on; 0 

== off 

  adxl.setInactivityX(1);// Melihat peregerakan tidak  

aktif sumbu XYZ, jika 1 =on dan 0 = 0ff   

  adxl.setInactivityY(1); 

  adxl.setInactivityZ(1); 

  

  //look of tap movement on this axes - 1 == on; 0 == off 

  adxl.setTapDetectionOnX(0); 

  adxl.setTapDetectionOnY(0); 

  adxl.setTapDetectionOnZ(1); 

  

  //setting nilai Threshold Average Precision (TAP):batasan 

presisi rata-rata (0-255) 

  adxl.setTapThreshold(50); // setting batas Threshold 

Average Precision (TAP) 

  adxl.setTapDuration(15); // setting durasi Threshold 

Average Precision (TAP)  

  adxl.setDoubleTapLatency(80); // setting pergerakan 

Threshold Average Precision (TAP) 
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  adxl.setDoubleTapWindow(200); // setting Panjang 

pergerakan Threshold Average Precision (TAP) 

 

  

  //setting value nilai untuk gerak jatuh bebas (0-255) 

  adxl.setFreeFallThreshold(7); //setting Batasan gerak 

jatuh bebas 62.5miligravitasi per gerakan 

  adxl.setFreeFallDuration(45); // setting durasi gerak 

jatuh bebas 5m/s per gerakan 

 

  

  //setting semua interrupts di atas 

  adxl.setInterruptMapping( ADXL345_INT_SINGLE_TAP_BIT,   

ADXL345_INT1_PIN ); // pemetaan interrupts, Single TAP 

setara 6 Bit ke pin D1  

  adxl.setInterruptMapping( ADXL345_INT_DOUBLE_TAP_BIT,   

ADXL345_INT1_PIN ); // pemetaan interrupts, Double TAP 

setara 5 Bit ke pin D1 

  adxl.setInterruptMapping( ADXL345_INT_FREE_FALL_BIT,    

ADXL345_INT1_PIN ); // pemetaan interrupts, gerak jatuh 

bebas setara 2 Bit ke pin D1 

  adxl.setInterruptMapping( ADXL345_INT_ACTIVITY_BIT,     

ADXL345_INT1_PIN ); // pemetaan interrupts, activity setara 

4 Bit ke pin D1 

  adxl.setInterruptMapping( ADXL345_INT_INACTIVITY_BIT,   

ADXL345_INT1_PIN ); // pemetaan interrupts, inactivity 

setara 3 Bit ke pin D1 

 

  

  //register interrupt aktif - 1 == on; 0 == off   

  adxl.setInterrupt( ADXL345_INT_SINGLE_TAP_BIT, 1); 

//setting interrupt , Single TAP setara 6 Bit on 
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  adxl.setInterrupt( ADXL345_INT_DOUBLE_TAP_BIT, 1); 

//setting interrupt , double TAP setara 5 Bit on 

  adxl.setInterrupt( ADXL345_INT_FREE_FALL_BIT,  1); 

//setting interrupt , gerak jatuh bebas setara 2 Bit on 

  adxl.setInterrupt( ADXL345_INT_ACTIVITY_BIT,   1); 

//setting interrupt , activity setara 4 Bit on 

  adxl.setInterrupt( ADXL345_INT_INACTIVITY_BIT, 1); 

//setting interrupt , inactivity setara 3 Bit on 

 

} 

void loop(){ 

  // Output asli  x,y,z values dalam bentuk bit data 

  int x,y,z;  // masukkan inputan sumbu XYZ 

  adxl.readXYZ(&x, &y, &z); //membaca nilai accelerometer 

dan variabel XYZ 

  Serial.print(x); // print nilai x 

  Serial.print("  "); 

  Serial.print(y); //print nilai x 

  Serial.print("  "); 

  Serial.println(z); //print nilai x 

 

  double xyz[3]; 

  double ax,ay,az; 

  adxl.getAcceleration(xyz); 

  ax = (xyz[0]*98); 

  ay = (xyz[1]*98); 

  az = (xyz[2]*98);// keterangan tersebut Merubah nilai 

asli keluaran sensor menjadi bentuk percepatan dengan 

satuan m/s^2 

  Serial.print("X="); //print percepatan sumbu  x 

  Serial.print(ax); //print percepatan sumbu  x 

  Serial.println("m/s^2");//print satuan percepatan sumbu x 

  Serial.print("Y=");//print percepatan sumbu   y 
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  Serial.print(ay); //print percepatan sumbu  y 

  Serial.println("m/s^2");//print satuan percepatan sumbu y 

  Serial.print("Z="); //print percepatan sumbu  z 

  Serial.print(az); //print percepatan sumbu  z 

  Serial.println("m/s^2");//print satuan percepatan sumbu z 

 

  Serial.println("**********************"); 

  delay(500); 

   

  Udp.beginPacket(remoteIp,remotePort); 

  Udp.println(ax);  

  Udp.endPacket(); 

  delay(500);// digunakan untuk mengirim data percepatan ke 

labview 

} 
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Lampiran 5 

Data Uji Karakteristik Alat Ukur Vibrasi 

1. Perulangan 1 m/s2 
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2. Perulangan 2 m/s2 
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3. Perulangan 3 m/s2 
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4. Perulangan 4 m/s2 
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5. Perulangan 5 m/s2 
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Lampiran 6 

Data Vibrasi Induced Draft Fan Berdasarkan Wi-Fi 

1. Jarak 10 Meter 

 
 

m/s^2 
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2. Jarak 20 Meter  

 
 

m/s^2 
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3. Jarak 30 Meter  

 
 

m/s^2 
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4. Jarak 40 Meter 

 

m/s^2 
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5. Jarak 50 Meter 

 
 

m/s^2 
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6. Jarak 80 Meter  

 

m/s^2 
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The ESP8266 is the name of a micro controller designed by Espressif Systems. The 
ESP8266 itself is a self-contained WiFi networking solution offering as a bridge from 
existing micro controller to WiFi and is also capable of running self-contained applications. 

This module comes with a built in USB connector and a rich assortment of pin-outs. With a 
micro USB cable, you can connect NodeMCU devkit to your laptop and flash it without any 
trouble, just like Arduino. It is also immediately breadboard friendly. 

  

ESP8266 NodeMCU WiFi Devkit 
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1. Specification: 
• Voltage:3.3V. 
• Wi-Fi Direct (P2P), soft-AP. 
• Current consumption: 10uA~170mA. 
• Flash memory attachable: 16MB max (512K normal). 
• Integrated TCP/IP protocol stack. 
• Processor: Tensilica L106 32-bit. 
• Processor speed: 80~160MHz. 
• RAM: 32K + 80K. 
• GPIOs: 17 (multiplexed with other functions). 
• Analog to Digital: 1 input with 1024 step resolution. 
• +19.5dBm output power in 802.11b mode 
• 802.11 support: b/g/n. 
• Maximum concurrent TCP connections: 5. 

2. Pin Definition: 

 

3. Using Arduino IDE 
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The most basic way to use the ESP8266 module is to use serial commands, as the chip is basically a WiFi/Serial 
transceiver. However, this is not convenient. What we recommend is using the very cool Arduino ESP8266 project, 
which is a modified version of the Arduino IDE that you need to install on your computer. This makes it very 
convenient to use the ESP8266 chip as we will be using the well-known Arduino IDE. Following the below step to 
install ESP8266 library to work in Arduino IDE environment.  

3.1 Install the Arduino IDE 1.6.4 or greater 
Download Arduino IDE from Arduino.cc (1.6.4 or greater) - don't use 1.6.2 or lower version! You can use your 
existing IDE if you have already installed it. 

You can also try downloading the ready-to-go package from the ESP8266-Arduino project, if the proxy is giving you 
problems. 

3.2 Install the ESP8266 Board Package 
Enter http://arduino.esp8266.com/stable/package_esp8266com_index.json into Additional Board Manager URLs 
field in the Arduino v1.6.4+ preferences. 

 

Click ‘File’ -> ‘Preferences’ to access this panel. 

Next, use the Board manager to install the ESP8266 package. 

https://www.arduino.cc/en/Main/Software�
https://www.arduino.cc/en/Main/Software�
https://github.com/esp8266/Arduino�
https://github.com/esp8266/Arduino�
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Click ‘Tools’ -> ‘Board:’ -> ‘Board Manager…’ to access this panel. 

Scroll down to ‘ esp8266 by ESP8266 Community ’ and click “Install” button to install the ESP8266 library package. 
Once installation completed, close and re-open Arduino IDE for ESP8266 library to take effect. 

3.3 Setup ESP8266 Support 
When you've restarted Arduino IDE, select ‘Generic ESP8266 Module’ from the ‘Tools’ -> ‘Board:’ dropdown menu. 

 

 
Select 80 MHz as the CPU frequency (you can try 160 MHz overclock later) 
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Select ‘115200’ baud upload speed is a good place to start - later on you can try higher speeds but 115200 is a good 
safe place to start. 

 
 
 
Go to your Windows ‘Device Manager’ to find out which Com Port ‘USB-Serial CH340’ is assigned to. Select the 
matching COM/serial port for your CH340 USB-Serial interface. 
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Find out which Com Port is assign for CH340 Select the correct Com Port as indicated on ‘Device Manager” 
 
Note: if this is your first time using CH340 “ USB-to-Serial ” interface, please install the driver first before proceed 
the above Com Port setting. The CH340 driver can be download from the below site: 
 

3.4 Blink Test 

https://github.com/nodemcu/nodemcu-devkit/tree/master/Drivers 
 

 

We'll begin with the simple blink test. 

Enter this into the sketch window (and save since you'll have to). Connect  a LED as shown in Figure3-1. 

 

void setup() { 
  pinMode(5, OUTPUT);   // GPIO05, Digital Pin D1 
} 
 
void loop() { 
  digitalWrite(5, HIGH); 
  delay(900); 
  digitalWrite(5, LOW); 
  delay(500); 
} 
 

 
 

Now you'll need to put the board into bootload mode. You'll have to do this before each upload. There is no timeout 
for bootload mode, so you don't have to rush! 
 

• Hold down the ‘Flash’ button. 
• While holding down ‘ Flash’, press the ‘RST’ button. 
• Release ‘RST’, then release ‘Flash’ 

https://github.com/nodemcu/nodemcu-devkit/tree/master/Drivers�
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Figure 3.2: Uploading the sketch to ESP8266 NodeMCU module. 

The sketch will start immediately - you'll see the LED blinking. Hooray! 

 

3.5 Connecting via WiFi 
 

OK once you've got the LED blinking, let’s go straight to the fun part, connecting to a webserver. Create a new sketch 
with this code: 

Don’t forget to update: 

const char* ssid     = "yourssid"; 

const char* password = "yourpassword"; 

to your WiFi access point and password, then upload the same way: get into bootload mode, then upload code via 
IDE. 

 

/* 
 *  Simple HTTP get webclient test 
 */ 
 

#include <ESP8266WiFi.h> 
 
const char* ssid     = "handson";     // key in your own SSID 
const char* password = "abc1234";     // key in your own WiFi access point 
password 
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const char* host = "www.handsontec.com"; 
 
void setup() { 
  Serial.begin(115200); 
  delay(100); 
 
  // We start by connecting to a WiFi network 
 
  Serial.println(); 
  Serial.println(); 
  Serial.print("Connecting to "); 
  Serial.println(ssid); 
   
  WiFi.begin(ssid, password); 
   
  while (WiFi.status() != WL_CONNECTED) { 
    delay(500); 
    Serial.print("."); 
  } 
 
  Serial.println(""); 
  Serial.println("WiFi connected");   
  Serial.println("IP address: "); 
  Serial.println(WiFi.localIP()); 
} 
 
int value = 0; 
 
void loop() { 
  delay(5000); 
  ++value; 
 
  Serial.print("connecting to "); 
  Serial.println(host); 
   
  // Use WiFiClient class to create TCP connections 
  WiFiClient client; 
  const int httpPort = 80; 
  if (!client.connect(host, httpPort)) { 
    Serial.println("connection failed"); 
    return; 
  } 
   
  // We now create a URI for the request 
  String url = "/projects/index.html"; 
  Serial.print("Requesting URL: "); 
  Serial.println(url); 
   
  // This will send the request to the server 
  client.print(String("GET ") + url + " HTTP/1.1\r\n" + 
               "Host: " + host + "\r\n" +  
               "Connection: close\r\n\r\n"); 
  delay(500); 
   
  // Read all the lines of the reply from server and print them to Serial 
  while(client.available()){ 
    String line = client.readStringUntil('\r'); 
    Serial.print(line); 
  } 
   
  Serial.println(); 
  Serial.println("closing connection"); 
} 
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Open up the IDE serial console at 115200 baud to see the connection and webpage printout! 
 

 

 

That's it, pretty easy right ! This section is just to get you started and test out your module. 

 

 

 

 

 

 



 

3-Axis, ±2 g/±4 g/±8 g/±16 g  

Digital Accelerometer 

Data Sheet ADXL345 
 

FEATURES 

Ultralow power: as low as 23 µA in measurement mode and 

0.1 µA in standby mode at VS = 2.5 V (typical) 

Power consumption scales automatically with bandwidth 

User-selectable resolution 

Fixed 10-bit resolution 

Full resolution, where resolution increases with g range, 

up to 13-bit resolution at ±16 g (maintaining 4 mg/LSB 

scale factor in all g ranges) 

Embedded memory management system with FIFO 

technology minimizes host processor load 

Single tap/double tap detection 

Activity/inactivity monitoring 

Free-fall detection 

Supply voltage range: 2.0 V to 3.6 V 

I/O voltage range: 1.7 V to VS 

SPI (3- and 4-wire) and I2C digital interfaces 

Flexible interrupt modes mappable to either interrupt pin 

Measurement ranges selectable via serial command 

Bandwidth selectable via serial command 

Wide temperature range (−40°C to +85°C) 

10,000 g shock survival 

Pb free/RoHS compliant 

Small and thin: 3 mm × 5 mm × 1 mm LGA package 

APPLICATIONS 

Handsets 

Medical instrumentation 

Gaming and pointing devices 

Industrial instrumentation 

Personal navigation devices 

Hard disk drive (HDD) protection 

GENERAL DESCRIPTION 

The ADXL345 is a small, thin, ultralow power, 3-axis accelerometer 
with high resolution (13-bit) measurement at up to ±16 g. Digital 
output data is formatted as 16-bit twos complement and is acces-
sible through either a SPI (3- or 4-wire) or I2C digital interface. 

The ADXL345 is well suited for mobile device applications. It 
measures the static acceleration of gravity in tilt-sensing appli-
cations, as well as dynamic acceleration resulting from motion 
or shock. Its high resolution (3.9 mg/LSB) enables measurement 
of inclination changes less than 1.0°. 

Several special sensing functions are provided. Activity and 
inactivity sensing detect the presence or lack of motion by 
comparing the acceleration on any axis with user-set thresholds. 
Tap sensing detects single and double taps in any direction. Free-
fall sensing detects if the device is falling. These functions can 
be mapped individually to either of two interrupt output pins.  
An integrated memory management system with a 32-level first in, 
first out (FIFO) buffer can be used to store data to minimize host 
processor activity and lower overall system power consumption. 

Low power modes enable intelligent motion-based power 
management with threshold sensing and active acceleration 
measurement at extremely low power dissipation. 

The ADXL345 is supplied in a small, thin, 3 mm × 5 mm × 1 mm, 
14-lead, plastic package. 

 

FUNCTIONAL BLOCK DIAGRAM 

3-AXIS
SENSOR

SENSE
ELECTRONICS DIGITAL

FILTER

ADXL345 POWER
MANAGEMENT

CONTROL
AND

INTERRUPT
LOGIC

SERIAL I/O

INT1

VS VDD I/O

INT2

SDA/SDI/SDIO

SDO/ALT
ADDRESS

SCL/SCLK

GND

ADC

32 LEVEL
FIFO

CS

0
7
9
2
5
-0
0
1

 
Figure 1.  
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ADXL345 Data Sheet 
 

SPECIFICATIONS 
TA = 25°C, VS = 2.5 V, VDD I/O = 1.8 V, acceleration = 0 g, CS = 10 µF tantalum, CI/O = 0.1 µF, output data rate (ODR) = 800 Hz, unless 
otherwise noted. All minimum and maximum specifications are guaranteed. Typical specifications are not guaranteed.  

Table 1.  

Parameter Test Conditions Min Typ1 Max Unit 

SENSOR INPUT Each axis     

Measurement Range User selectable  ±2, ±4, ±8, ±16  g 

Nonlinearity Percentage of full scale  ±0.5  % 

Inter-Axis Alignment Error    ±0.1  Degrees 

Cross-Axis Sensitivity2   ±1  % 

OUTPUT RESOLUTION Each axis     

All g Ranges 10-bit resolution  10  Bits 

±2 g Range Full resolution  10  Bits 

±4 g Range Full resolution  11  Bits 

±8 g Range Full resolution  12  Bits 

±16 g Range Full resolution  13  Bits 

SENSITIVITY  Each axis     

Sensitivity at XOUT, YOUT, ZOUT  All g-ranges, full resolution 230 256 282 LSB/g 

 ±2 g, 10-bit resolution 230 256 282 LSB/g 

 ±4 g, 10-bit resolution 115 128 141 LSB/g 

 ±8 g, 10-bit resolution 57 64 71 LSB/g 

 ±16 g, 10-bit resolution 29 32 35 LSB/g 

Sensitivity Deviation from Ideal All g-ranges  ±1.0  % 

Scale Factor at XOUT, YOUT, ZOUT  All g-ranges, full resolution 3.5 3.9 4.3 mg/LSB 

 ±2 g, 10-bit resolution 3.5 3.9 4.3 mg/LSB 

 ±4 g, 10-bit resolution 7.1 7.8 8.7 mg/LSB 

 ±8 g, 10-bit resolution 14.1 15.6 17.5 mg/LSB 

 ±16 g, 10-bit resolution 28.6 31.2 34.5 mg/LSB 

Sensitivity Change Due to Temperature   ±0.01  %/°C 

0 g OFFSET Each axis     

0 g Output for XOUT, YOUT  −150 0 +150 mg 

0 g Output for ZOUT  −250 0 +250 mg 

0 g Output Deviation from Ideal, XOUT, YOUT   ±35  mg 

0 g Output Deviation from Ideal, ZOUT   ±40  mg 

0 g Offset vs. Temperature for X-, Y-Axes   ±0.4  mg/°C 

0 g Offset vs. Temperature for Z-Axis   ±1.2   mg/°C 

NOISE      

X-, Y-Axes ODR = 100 Hz for ±2 g, 10-bit resolution or 
all g-ranges, full resolution 

 0.75  LSB rms 

Z-Axis ODR = 100 Hz for ±2 g, 10-bit resolution or  
all g-ranges, full resolution 

 1.1  LSB rms 

OUTPUT DATA RATE AND BANDWIDTH User selectable     

Output Data Rate (ODR)3, 4, 5  0.1  3200 Hz 

SELF-TEST6      
Output Change in X-Axis  0.20  2.10  g 

Output Change in Y-Axis  −2.10   −0.20  g 

Output Change in Z-Axis  0.30  3.40  g 

POWER SUPPLY      
Operating Voltage Range (VS)  2.0 2.5 3.6 V 

Interface Voltage Range (VDD I/O)  1.7 1.8 VS V 

Supply Current  ODR ≥ 100 Hz  140   µA 

 ODR < 10 Hz  30   µA 

Standby Mode Leakage Current   0.1  µA 

Turn-On and Wake-Up Time7 ODR = 3200 Hz  1.4  ms 

Rev. E | Page 4 of 40 
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Parameter Test Conditions Min Typ1 Max Unit 

TEMPERATURE      

Operating Temperature Range  −40  +85 °C 

WEIGHT      

Device Weight   30  mg 

1 The typical specifications shown are for at least 68% of the population of parts and are based on the worst case of mean ±1 σ, except for 0 g output and sensitivity, 
which represents the target value. For 0 g offset and sensitivity, the deviation from the ideal describes the worst case of mean ±1 σ. 

2 Cross-axis sensitivity is defined as coupling between any two axes. 
3 Bandwidth is the −3 dB frequency and is half the output data rate, bandwidth = ODR/2. 
4 The output format for the 3200 Hz and 1600 Hz ODRs is different than the output format for the remaining ODRs. This difference is described in the Data Formatting of 

Upper Data Rates section. 
5 Output data rates below 6.25 Hz exhibit additional offset shift with increased temperature, depending on selected output data rate. Refer to the Offset Performance at 

Lowest Data Rates section for details. 
6 Self-test change is defined as the output (g) when the SELF_TEST bit = 1 (in the DATA_FORMAT register, Address 0x31) minus the output (g) when the SELF_TEST bit = 

0. Due to device filtering, the output reaches its final value after 4 × τ when enabling or disabling self-test, where τ = 1/(data rate). The part must be in normal power 
operation (LOW_POWER bit = 0 in the BW_RATE register, Address 0x2C) for self-test to operate correctly. 

7 Turn-on and wake-up times are determined by the user-defined bandwidth. At a 100 Hz data rate, the turn-on and wake-up times are each approximately 11.1 ms. For 
other data rates, the turn-on and wake-up times are each approximately τ + 1.1 in milliseconds, where τ = 1/(data rate). 

 

 

 

Rev. E | Page 5 of 40 

 



ADXL345 Data Sheet 
 

ABSOLUTE MAXIMUM RATINGS 
Table 2.  

Parameter Rating 

Acceleration  

Any Axis, Unpowered 10,000 g 

Any Axis, Powered 10,000 g 

VS −0.3 V to +3.9 V 

VDD I/O −0.3 V to +3.9 V 

Digital Pins −0.3 V to VDD I/O + 0.3 V or 3.9 V,  
whichever is less 

All Other Pins −0.3 V to +3.9 V 

Output Short-Circuit Duration  
(Any Pin to Ground) 

Indefinite 

Temperature Range  

Powered −40°C to +105°C 

Storage −40°C to +105°C 

Stresses at or above those listed under Absolute Maximum 
Ratings may cause permanent damage to the product. This is a 
stress rating only; functional operation of the product at these 
or any other conditions above those indicated in the operational 
section of this specification is not implied. Operation beyond 
the maximum operating conditions for extended periods may 
affect product reliability. 

 

 

 

 

 

 

 

 

 

 

 

 

THERMAL RESISTANCE 

Table 3. Package Characteristics 

Package Type θJA θJC Device Weight 

14-Terminal LGA 150°C/W 85°C/W 30 mg 

PACKAGE INFORMATION 

The information in Figure 2 and Table 4 provide details about 
the package branding for the ADXL345. For a complete listing 
of product availability, see the Ordering Guide section. 

0
7
9
2
5
-1
0
2

3 4 5 B

# y w w

v v v v

C N T Y
 

Figure 2. Product Information on Package (Top View) 

Table 4. Package Branding Information 

Branding Key Field Description 

345B Part identifier for ADXL345 

# RoHS-compliant designation 

yww Date code 

vvvv Factory lot code 

CNTY Country of origin 

 

ESD CAUTION 
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PIN CONFIGURATION AND FUNCTION DESCRIPTIONS 
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NOTES
1. NC = NO INTERNAL CONNECTION.  

Figure 3. Pin Configuration (Top View) 

 

Table 5. Pin Function Descriptions 

Pin No. Mnemonic Description 

1 VDD I/O Digital Interface Supply Voltage. 

2 GND This pin must be connected to ground. 

3 RESERVED Reserved. This pin must be connected to VS or left open. 

4 GND This pin must be connected to ground. 

5 GND This pin must be connected to ground. 

6 VS Supply Voltage. 

7 CS Chip Select. 

8 INT1 Interrupt 1 Output. 

9 INT2 Interrupt 2 Output. 

10 NC Not Internally Connected. 

11 RESERVED Reserved. This pin must be connected to ground or left open. 

12 SDO/ALT ADDRESS Serial Data Output (SPI 4-Wire)/Alternate I2C Address Select (I2C). 

13 SDA/SDI/SDIO Serial Data (I2C)/Serial Data Input (SPI 4-Wire)/Serial Data Input and Output (SPI 3-Wire). 

14 SCL/SCLK Serial Communications Clock. SCL is the clock for I2C, and SCLK is the clock for SPI. 

 



r\---l

)

I

t
Jlc L

:; e:: i.-l

'qzJali -

:>1 - U;--= liS-,

-L-ui vc--t)t! -

: :ta -:i.l )?c-, 1j nl

P=oI IT'r; : E : o:3E-: iar.cd -

?"ol Ijrl r= r:trEa:rTlli -

pEaoq -

je::-.: -1E:iltr:'ii -

uci:ds,suc, .leAci -

./,3'..ia:3T;;e 3:f 
"l s -

Daad,s u".: -
_ t: 

^_rFA ^ c-i::>e;i J.-s->

a.l n; e:aiua;

IJE] -?i .41 rrede3

:=: =:

- 
=a =-

69'C

r --- )

EC:

/t,/r,.,

t

lui.I

qAr ut:ll

3"

q,/fuIN

(Fl 05/ vatuT/ 2>u

:C:--"i A)-i.^-l"S

/ ;1oi, f ze:c;

i o i..o;is'l E

f, r-r 3U

C.]'|"I

I'S9

ae6

CLa

0:-t

000 gt I

a d-{-r

:e:nl lE f nuEJ{ _

:eTsnN -

(sDrlsr.lalf,E.reril u6tsap ) su?j

I

i

I

'-./ IA ].ut-a

:l"f P pesnPuI '29'l



	■ Create Calibration Certificates for Vibration Instrumentation

	■ Calibrate Vibration Analyzers & Meters In-House

	■ Confirm Critical Vibration Shutdown Alarms & Logic

	■ Detect Sensor Drift & Amplified Outputs at Key Frequencies

	■ Prevent Early or Late Shutdowns Due to Proximity Probe 
Errors

	■ Compliance to API 670 & ISO 9001

TYPICAL APPLICATIONS
	■ In-House Calibration of Vibration Instrumentation

	■ Safety Instrumented Systems (SIS)

	■ Loop Checks & System Troubleshooting, DCS & PLC

	■ Proximity Probe Testing and Checks for Mismatched Systems

	■ On-Turbine Vibration Sensors & Charge Amplifiers

modalshop.com/vibration-calibrator | 1 513 351 9919

M O D E L  9 1 1 0 D LAB ACCURACY TO THE FIELD

The 9110D Portable Vibration Calibrator is the ideal tool for checking 
accelerometers, velocity transducers, and proximity probes over a 
wide operating frequency and amplitude range. The unit is a compact, 
battery-powered, and completely self-contained vibration reference 
source, which can be conveniently used to calibrate individual sensors, 
vibration switches, and data collectors, as well as to validate the entire 
measurement channel of a condition monitoring or recording system. 
An integral precision quartz reference accelerometer and closed-
loop level control gives the 9110D enhanced stability and superior 
vibration calibration over an extended 5 Hz to 10 kHz frequency 
range. Packaged in a rugged Pelican® Storm case, the 9110D is 
always ready for travel to test sites, bringing laboratory accuracy  
to the field.

Additional features include an ICP®, voltage, charge mode or modulated 
current test sensor input for direct connection and readout of the 
most common types of accelerometers and velocity transducers. The 
test sensor sensitivity is calculated and displayed on the screen in 
real time. The unit’s internal memory capability can store up to 500 
calibration records, and data can be easily transferred to a computer 
through a USB flash drive. This allows for the creation and printing 
of ISO 17025-compliant, customizable calibration certificates and 
reports using the supplied Excel® workbook template. The workbook 
is also used to program repetitive tests into the calibrator along with 

pass/fail tolerances for each data point.

New CALROUTE firmware allows technicians to program repetitive 
calibration test points and pass/fail tolerances. Once programmed 
via supplied Microsoft Excel® workbook, technicians can perform 
calibrations rapidly and receive instant pass/fail feedback. No additional 
software is needed to program the calibrator or create reports.

IECEx IECEx

IECEx

IECEx

PORTABLE 
VIBRATION 
CALIBRATOR



SPECIFICATIONS
Performance

Frequency Range (operating) [1] 5 Hz to 10 kHz 300 to 600k CPM

Maximum Amplitude 
     (50 Hz, 10-gram payload)

20 g pk 196 m/s2 pk

20 in/s pk 500 mm/s pk

150 mils pk-pk 3.8 mm pk-pk

Maximum Amplitude 
     (50 Hz, 500-gram payload)

2.5 g pk 24.5 m/s2 pk

3.5 in/s pk 90 mm/s pk

Maximum Payload [2] 800 grams

Test Operation Manual (Closed Loop) or Semi-Automatic

Auto-Payload Calculation Controlled via Reference Accelerometer,
No User Entry Required

Memory

Stores 500 Calibration Records; Stores 30 
Data Points Per Calibration Record; Stores 
Model Number, Serial Number, Mounting 

Orientation & Notes for each Record; Stores 
Semi-Automated Test Routine

Non-Volatile Memory Up to 30 Test Points per Routine with Pass/
Fail Upper & Lower Bound Tolerances

Programmability Manual (Closed Loop) or Semi-Automatic

Accuracy of Readout [3]

     Acceleration (10 Hz to 10 kHz) ±3 % [4]

     Acceleration (5 Hz to 10 Hz) ±5 % [4]

     Velocity (10 Hz to 1000 Hz) ±3 %

     Displacement (30 Hz to 150 Hz) ±3 %

     Accuracy Verification Test Field Drift Test Procedure Provided [5]

Units of Readout

     Acceleration (pk and RMS) g m/s2

     Velocity (pk and RMS) in/s mm/s

     Displacement (pk to pk) mils µm

     Frequency Hz CPM

Physical

Sensor Under Test Sensitivity mV/EU, mA/EU, µA/EU or pC/EU

AC Power (for recharging battery) 110–240 VAC, 50–60 Hz

Operating Battery Life [6]: 

100 Hz, 1 g pk [1] 18 hours

Sensor Under Test Input ICP, Voltage, Modulated Current, Charge [7]

Monitor Reference Out 10 mV/g (nominal) Quartz Reference 
Accelerometer, BNC Jack Output

USB Port

Export Calibration Records to Flash Drive 
(FAT 32), Used for Loading Semi-Automated 

Test Routines (Model CALROUTE) & 
provides power for external power supplies

Dimensions (H x W x D) 8.5 x 12 x 10 in 22 x 30.5 x 28 cm

Weight 18 lb 8.2 kg

Sensor Mounting Platform ¼-28 Thread Size

Export File Format CSV (comma-separated values)

Meets API 670 requirements for all required test points in acceleration or velocity from 10 Hz to 
1000 Hz & payloads to 800 grams. 

[1]   100-gram payload
[2]   Operating range reduced at higher payloads. Reference manual for full details.
[3]   Measured with 10-gram quartz reference accelerometer
[4]   Calculated by measuring the % difference between the known sensitivity of a reference  
        accelerometer as calibrated by laser primary system per ISO 16063-11 and the measured  
        sensitivity of same reference accelerometer when tested at the same points
[5]   Test is conducted independently of product firmware with calibrated voltmeter
[6]   As shipped from factory in new condition
[7]   External Charge Amplifier Required
[8]   For a comprehensive list of available accessories, see Product Spec Sheet or call
[9]   For metric unit micrometers, use Model 9100-MPPA01
[10] Mounting plates support sensors listed. Multi-hole mounting plates are convenient but not 
        optimized for the best calibration results. The Modal Shop offers a full line of customized  
        mounting pads validated in our calibration lab for precise results. Contact us for more  
        information.

B&K: 8324
Bently Nevada: 330450, 330750, 350900 
CEC: 4-123, 4-125, 4-126, 4-128, 4-130,     
        4-137, 4-138, 4-170, 4-171 
Dytran: 3085C and 3235 series 
Endevco: 6233C, 6222M, 6222S, and 6240 Series

Metrix: 5485C, SA6350 
PCB Piezotronics: 357 & EX600B series,
                              EX615A42 and EX619A11 
Vibro-Meter: CA 134, CE 134, CA 202, 
                      CA 280, CE 281, CA 303,
                      CA 306, CE 311

SPECIFICATIONS (continued)
Operating Temperature 32 °F–122 °F 0 °C–50 °C

Supplied Accessories [8]

081B20 ¼-28 to ¼-28 Adaptor

081A08 10-32 to ¼-28 Adaptor

M081A63 M8 x 1.25 M to ¼-28 M Mounting Stud

PVC-MNT01 M8 x 1.25 F Thru Hole Mounting Pad

081M165 M8 x 1 M to ¼-28 M Mounting Stud

PVC-MNT02 M8 x 1 F Thru Hole Mounting Pad

PVC-HTMNT01 Mounting Plate, 3- & 4-Hole High-Temp Vibration Sensors [10]

PVC-HTMNT02 Mounting Plate, 3- & 4-Hole High-Temp Vibration Sensors [10]

9100-CAL01 NIST Traceable Certificate of Calibration, 
Accredited to ISO 17025 by A2LA

9110-USB USB Flash Memory Drive: Loaded with Calibration Report 
Generation Workbook

Calibration 
Report 
Generation 
Workbook

Certificate Generated Via 9110D Memory: Frequency 
Response & Linearity for AC Voltage Output Transducers 

Certificate Generated Via User-Input: Vibration analyzer/meter 
linearity & frequency response accuracy, linearity for 4-20 mA 

vibration transmitters, proximity probe curves (gap vs.  
DC voltage)

Quickstart 
Guide

Available in English, Chinese, French, Japanese, Polish, 
Russian, & German

Warranty 2 Years, Inclusive of Drift/Accuracy

Tech Support Training Webinars Available Upon Request, 24/7 Video Library

Optional Accessories [8]

9100-PPASH Proximity probe adaptor kit for testing probes mounted inside 
a probe holder

9155-MNT93 ½-20 F to ¼-28 F Mounting

9155-MNT43 ¼” NPT F Mounting Adaptor to ¼-28 M

9100-PPA01 Proximity probe adaptor kit for probes with 5 mm or 8 mm tip 
diameter [9]

9100- 
HTCHRGKIT High-temp charge mode accel calibration accessory kit

2
MTS Sensors, a division of MTS Systems Corporation (NASDAQ: MTSC), vastly expanded its range of products and solutions after MTS acquired  
PCB Piezotronics, Inc. in July, 2016. PCB Piezotronics, Inc. is a wholly owned subsidiary of MTS Systems Corp.; IMI Sensors and Larson Davis are 
divisions of PCB Piezotronics, Inc.; Accumetrics, Inc. and The Modal Shop, Inc. are subsidiaries of PCB Piezotronics, Inc.

DS-0103 revF

10310 Aerohub Boulevard, Cincinnati, OH 45215 USA
Toll-Free in the USA: 800 860 4867
Phone: 1 513 351 9919  |  Email: info@modalshop.com

The Modal Shop, Inc. offers structural vibration and acoustic sensing systems and services for 
various applications in design and test laboratories as well as manufacturing plants. An extensive 
sound and vibration rental program, precision calibration systems, and both modal and vibration 
shakers are designed to simplify test phases. Non Destructive Testing Systems help manufacturers 
provide 100% quality inspection of metal components.  The Modal Shop, Inc. is a subsidiary of PCB 
Piezotronics, Inc., and PCB® is a wholly owned subsidiary of MTS Systems Corporation.   

© 2020 The Modal Shop, Inc. In the interest of constant product improvement, specifications are subject to change without notice. PCB®, ICP®, Swiveler®, Modally Tuned®, and IMI® with associated logo are registered trademarks of PCB 
Piezotronics, Inc. in the United States. ICP® is a registered trademark of PCB Piezotronics Europe GmbH in Germany and other countries. UHT-12TM is a trademark of PCB Piezotronics, Inc. SensorLineSM is a service mark of PCB Piezotronics, 
Inc. SWIFT® is a registered trademark of MTS Systems Corporation in the United States. All other trademarks are property of their respective owners. 
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